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This chapter provides an overview to the Vocera Report Server database schema. It contains the following
sections:

» How Report Server Works

¢ Writing Database Queries

» Connecting to the Vocera Report Server Database

¢ Installing Crystal Reports 2008 and MySQL Connector/ODBC 3.51

¢ Tables at a Glance

This document describes the tables used by the Vocera Report Server to generate reports based on data
gathered as people use the Vocera system. The Vocera server records events (for example, the start of a
badge call, Genie prompts, the end of a call) in log files. The Report server parses these files into database
tables and queries the tables to generate data for reports.

The following figure illustrates Report Server functionality. It shows how data is loaded from the Vocera
Server into the Report Server database. Report definition files (including custom reports) are created using
the Crystal Reports Designer. The Report Console generates reports.

Crystal Reports Report Vocera
Designer Console Server

5 & — 8

Report Logs & Entity Data

Report Generation RepOrt Serve
Engine
[ Data Load
Report ‘ Data Collection ‘
Definition Crystal Reports e
Files \1/1::> APls l .
‘ Data Processing ‘ \

ﬁ Command

Line
Interface

Report Server database ] R R /

A

‘ P e -
‘ Maintenance i

The files that define Vocera reports (for example, DailySystemCallVolume. rpt) are installed by default
in the \vocera\reports\Reports directory when you install the Vocera Report Server. To read and study
these files as a basis for your own custom reports, you must also install Crystal Reports. See Installing
Crystal Reports 2008 and MySQL Connector/ODBC 3.51.
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You can use the schema information to write queries and create custom reports based on the same data.
For example, the following query returns a list of the groups on a Vocera server by extracting values from
the GroupName column of the groups table:

select GroupName from groups;

Grouph ame i Site i

dBccoLnting z-qlabal
Adminiztration g-qlobal
Board Members = s-global
Cashiers s-glabal
Charge nurze z-glabal

select GroupMame
fram groups;

G rDuEN arme ;

dccounting
Adminiztration
Board Members
Cashiers
Charge nurse

Here's an example of how to get related data from two tables. The following query returns speech
recognition scores for a specified user:

select r.score, u.FirstName, u.LastName
from recresults r, users u
where r.UserID='rhall' and u.UserID='rhall"';

This query returns rows from both tables where the value of the UserID field is rhall.

select r.score,

u.Firstharne, u.LastMame

from recresults r, users u
where r.UserID="rhall’

and u.UseriD="rhall';

recresults
Tabdillis WaRCHAR[S]
Te CrabeTime LATETIME
UszerTupe WARCHARO]
User|[r R CHAR ]
U=er Site R CHARED)
Badge b ACAddr WYARCHARZ)
APMACADDr WARCHAR[Z)
Rz Status AR CHAR [40]
Score IMT[10]
R
1dGe Uzers
— |Userll WARCHARGEO)
UserMame “WARCHAR[255)
LastHame.  WARCHAR[E0)
FirstHamea  “ARCHAR[E0)
Lepartments “WARCHAR[100]
Site WARCHAREO)
CostCenters “WARCHAR([100]

SCOME i FirstMame | LastM amej

50 Robert Hall
s Robert Hall
53] R obert Hall

The following table lists connection parameters for the Vocera Report Server Database.

Table 1: Database connection parameters

Parameter

Database name

Value

vocera_reports
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Parameter Value
User name vocera
Password vocera

The following code example shows how to connect to the database and execute a query from a Java
application.

import java.sql.*;
//import java.util.*;

public class VRSConnection {
// Replace "vrsHost" with the host name or IP address
// of the Vocera Report Server.
static String sHost = "vrsHost";
static String sUsername "vocera";
static String sPassword "vocera";
static String sThinConn "jdbc:mysql://" + sHost +
"/vocera_reports";
static String driverClass = "com.mysql.jdbc.Driver";

public static Connection getConnection()
throws SQLException {
Connection ¢ = null;
try {
Class.forName(driverClass).newInstance();
¢ = DriverManager.getConnection(sThinConn,

sUsername,
sPassword);
catch (Exception e) {
e.printStackTrace(System.out);
¥
return c;
}
public static void main(String argv[]) {
try {
Connection conn = getConnection();
if (conn == null) {
System.out.println("No connection."); System.exit(9);
}
else {
System.out.println("Connected.");
Statement stmt = conn.createStatement();
String query = "SELECT SITENAME FROM SITES";
ResultSet rs = stmt.executeQuery(query);
while (rs.next()) {
System.out.println(rs.getString("SiteName"));
conn.close();
System.out.println("Connection closed.");
}
}

catch (SQLException sqle) {
sqle.printStackTrace();
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Install Crystal Reports 2008 Release 2 on a different computer from the Vocera Report Server. To connect
from Crystal Reports to your Vocera Report Server, you need to install the MySQL Connector/ODBC 3.51
driver and set up an ODBC data source.

' Important:
DO NOT install Crystal Reports Server on the same machine as Vocera Report Server. Vocera Report
Server has not been certified to work on computers where Crystal Reports Server is also installed.

To install Crystal Reports 2008 Release 2 and MySQL Connector/ODBC 3.51:

1. Download the MySQL Connector/ODBC 3.51 driver from the following location:
http:/dev.mysql.com/downloads/connector/odbc/3.51.html

=== Note:
=—=J Vocera Report Server requires MySQL Connector/ODBC 3.51.27 or later.

2. Install the MySQL Connector/ODBC 3.51 driver.

3. Set up an ODBC data source to connect to your Vocera Report Server:
a. Open the ODBC Data Source Administrator, which is usually found under Start > Programs >
Administrative Tools > Data Sources (ODBC), or Start > Settings > Control Panel > Data
Sources (ODBC). The ODBC Data Source Administrator dialog box opens.

b. Click the System DSN tab.
c. Click Add. The Create New Data Source dialog box opens.
d. Select the MySQL ODBC 3.51 driver from the list.
e. Click Finish.
f. The Connector/ODBC 3.51.x dialog box opens with the Login tab selected. Enter the following
information:
Field Value
Data Source Name VoceraReports
Description Vocera Report Server connection
Server [IP address of the Vocera Report Server machine]
User vocera
Password vocera
Database vocera_reports

=== Note:
The User and Password values above are the default values for Vocera Report Server. If you
changed the User and Password on the Vocera Report Server, use those values instead.

The Connector/ODBC 3.51.x dialog box should look like this:
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'Eonnector,.-"DDBE 3.51.23 - Add Data Source Name

Connector/0DBC

Login | Connect Options I Adwvanced I

Daka Source Mame I\hceraReports

Descripkion I Vocera Repart Server conneckion
Server |10.37.43.103

User I wOCera

Password I Hkdk

Database | wOCera_reporks LI

Connector/0ODBC Configuration

i| Diagnostics = |

This dialog is used to add a Data Source Name
(DS,

Ok | Cancel | Help |

OVERVIEW

g. Click OK to save the connection and close the Connector/ODBC 3.51.x dialog box.

h. In the ODBC Data Source Administrator dialog box, click OK.

Install Crystal Reports 2008 Release 2. For detailed instructions, see the separate Crystal Reports

documentation.

When prompted, restart the computer.
After the computer restarts, run Crystal Reports.

Log on to the VoceraReports data source:
a. Choose File > Log On or Off Server. The Data Explorer dialog box opens.
b. Expand the Create New Connection folder, and then expand the ODBC (RDO) folder. The ODBC (RDO)

dialog box opens.

c. Make sure the Select Data Source radio button is selected. In the Data Source Name list, select

VoceraReports. Click Next.
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Data Source Selection

Choose a data sounce from the list or open a file dzn from the browse

button

Select Data Sounce:

Data Source Mame:

Find File: DSN:
File: DS

Enter Connection String:

Connection Shing:

o)

dBASE Files

E=cel Files

M5 Access Database
Visio D atabaze Samples

VioceraReports
Htreme Sample D atabaze 11

~

| _

I

< Back I Mest » I Finizh | Cancel | Help |

OVERVIEW

d. Enter the UserID and Password. By default, both values are "vocera". If you changed the UserID
and Password on the Vocera Report Server, use those values instead.

e. Click Finish.

The Report server generates reports from logs and user data acquired from the Vocera server. This section
provides an overview of of tables of Vocera usage data maintained in the Vocera Report Server database.
Tables containing Report Server application data are excluded. Underlined columns indicate primary keys

for the table.

Column
LastName
FirstName
Type

Site

Phone
Pager
DeletedFlag

Column
TxMillis
TxDateTime
TxDate
Userld

11

Type
VARCHAR(50
VARCHAR(50
VARCHAR(50
VARCHAR(50
VARCHAR(50)
VARCHAR(50)
INT(1)

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(70)
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Column
UserSite
LoginId

Operation

ModifiedEntityType

ModifiedEntityId

Column
TxMillis
TxDateTime
TxDate
UserType
Userld
UserSite
GroupName
GroupSite
Duration
IdBroadcast
IdGenie
ModifiedEntityld

Column

TxMillis
TxDateTime
TxDate
UserType
UserID

UserSite
CalledType
Called
CalledName
CalledSite
Accepted
AcceptedByType
AcceptedBy
AcceptedByName
AcceptedBySite
DeviceType

Duration

12

Type

VARCHAR(50)
VARCHAR(50)
VARCHAR(30)
VARCHAR(20)
VARCHAR(70)

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(20)
VARCHAR(70)
VARCHAR(50)
VARCHAR(50)
VARCHAR(50)
BIGINT(15)
BIGINT(15)
BIGINT(15)
VARCHAR(70)

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(20)
VARCHAR(70)
VARCHAR(50)
VARCHAR(10)
VARCHAR(40)
VARCHAR(100)
VARCHAR(50)
INT(1)
VARCHAR(10)
VARCHAR(40)
VARCHAR(100)
VARCHAR(50)
VARCHAR(64)
BIGINT(15)

OVERVIEW
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Column

IdCall
IdGenie

Column

DevicelD

BadgeMACAddr

SerialNo
Label

Type

Color

Owner

Site
TrackingDate
BadgeUsage
Notes

DeviceCode

FirmwareVersion

LastStatus
LastUser

LasLastLocation

LastAccessed

InternalSerialNo

Column
Status
Description
DeletedFlag

Column
TxMillis
TxDateTime
TxDate
DevicelD
DeviceSite
Status
Notes

13

Type
BIGINT(20)
BIGINT(10)

Type
VARCHAR(20)
VARCHAR(12
VARCHAR(20)
VARCHAR(30)
VARCHAR(15)
VARCHAR(20)
VARCHAR(50)
VARCHAR(50)
DATE
TINYINT(1)
TEXT

INT(5)

INT(5)
VARCHAR(50)
VARCHAR(70)
VARCHAR(50)
TIMESTAMP
VARCHAR(20)

Type
VARCHAR(100
TEXT

INT(1)

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(20)
VARCHAR(50)
VARCHAR(30)
TEST

OVERVIEW
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Column
TxMillis
TxDateTime
TxDate
UserID
UserSite
DND

Column

TxMillis
TxDate
TxDateTime
UserID
UserSite
BadgeMACAddr

Failuretext

Column
TxMillis
TxDateTime
TxDate
UserType
UserID
UserSite
Operation
GroupName
GroupSite
PartyID
PartySite
IdGenie

Column
TxMillis
TxDateTime
TxDate

UserType
UserID

14

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(70
VARCHAR(50)
INT(1)

Type
BIGINT(15)
DATE
DATETIME
VARCHAR(70)
VARCHAR(50)
VARCHAR(12)
VARCHAR(50)

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(20)
VARCHAR(70)
VARCHAR(50)
VARCHAR(64)
VARCHAR(50)
VARCHAR(50)
VARCHAR(70)
VARCHAR(50)
BIGINT(15)

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(20)
VARCHAR(70)

OVERVIEW
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Column
UserSite
GroupName
GroupSite
Duration
IdGroupConf
IdGenie

Column
GroupID
GroupName
Site
CostCenter
DeletedFlag
UserMembers

Department

Column
TxMillis
TxDateTime

Type
ReportData

Column
TxMillis
TxDateTime
TxDate
UserID
UserSite

BadgeMACAddr

APMACAddr
Voltage
UlState

SerialNo

Column
MACAddress

LocationName
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Type
VARCHAR(50)
VARCHAR(50)
VARCHAR(50)
BIGINT(15)
BIGINT(15)
BIGINT(15)

Type
VARCHAR(50)
VARCHAR(50)
VARCHAR(50)
VARCHAR(100)
INT(1)
MEDIUMTEXT
VARCHAR(50)

Type
BIGINT(15)
DATETIME
VARCHAR(20)
TEXT

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(70)
VARCHAR(50)
VARCHAR(12)
VARCHAR(12)
DECIMAL(7,2)
VARCHAR(15)
VARCHAR(30)

Type
VARCHAR(20
VARCHAR(50)

OVERVIEW
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Column
Site
DeletedFlag

Column

TxMillis
TxDateTime
TxDate

UserID

UserSite
UserSite
Operation
DeviceMACAddr
APMACAddr
LoginUserCount

TotalLic

Column

id
TxParentMillis
TxMillis
TxDateTime
APMacAddress
OtherParty

Type

Column
TxMillis
TxDateTime
TxDate
UserID
UserSite
BadgeMacAddress
BadgeBinary
SFAPCount
CAPCount
LSCount
SFSCount

16

Type
VARCHAR(50)
INT(1)

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(70)
VARCHAR(50)
VARCHAR(50)
VARCHAR(64)
VARCHAR(12)
VARCHAR(12)
INT(11)
INT(11)

Type

INT(11
VARCHAR(15)
BIGINT(15)
DATETIME
VARCHAR(12)
VARCHAR(20)
VARCHAR(10)

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(70)
VARCHAR(50)
VARCHAR(12)
TEXT
SMALLINT(6)
SMALLINT(6)
SMALLINT(6)
SMALLINT(6)

OVERVIEW
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Column
SFDHCPCount

Duration

Column
TxMillis
TxDateTime
TxDate
UserType
UserID
UserSite
Operation
Parties
Parties
Duration
IdMsgActivity
IdGenie

Column

reportName
reportTime

Column

id
TxParentMillis
TxMillis
TxDateTime
APMacAddress
OtherParty
PacketsReceived
PacketsMissed
cQ

RoamTime
Type
Reservedl
Reserved2

Reserved3
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Type
SMALLINT(6)
SMALLINT(6)

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(20)
VARCHAR(70)
VARCHAR(50)
VARCHAR(64)
VARCHAR(512)
VARCHAR(512)
BIGINT(15)
BIGINT(15)
BIGINT(15)

Type
VARCHAR(50
BIGINT(15)

Type

INT(11)
VARCHAR(15)
BIGINT(15)
DATETIME
VARCHAR(12)
VARCHAR(20)
SMALLINT(6)
SMALLINT(6)
SMALLINT(6)
MEDIUMINT(9)
SMALLINT(1)
MEDIUMINT(9)
MEDIUMINT(9)
MEDIUMINT(9)

OVERVIEW
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Column
TxMillis
TxDateTime
TxDate
UserID
UserSite

BadgeMacAddress

BadgeBinary

PacketsReceived

PacketsMissed
AvgCQ

JBhit
JBMissed
Type
Reservedl
Reserved2

Reserved3

Column
TxMillis
TxDateTime
TxDate
UserType
UserID
UserSite

BadgeMACAddr

APMACAddr
RecStatus
Score
Recognized
Grammar
DeviceType
IdGenie

Column
Siteld
SiteName
DeletedFlag
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Type

BIGINT(15)
DATETIME
DATE
VARCHAR(70)
VARCHAR(50)
VARCHAR(12)
TEXT
SMALLINT(6)
SMALLINT(6)
SMALLINT(6)
MEDIUMINT(9)
MEDIUMINT(9)
SMALLINT(1)
MEDIUMINT(9)
MEDIUMINT(9)
MEDIUMINT(9)

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(20)
VARCHAR(70)
VARCHAR(50)
VARCHAR(12)
VARCHAR(12)
VARCHAR(40)
INT(10)
VARCHAR(50)
VARCHAR(64)
VARCHAR(64)
BIGINT(15)

Type
VARCHAR(50)
VARCHAR(50)
INT(1)

OVERVIEW
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Column
TxMillis
TxDateTime
TxDate
UserType
UserID
UserSite
Duration
SpeechPort
IdGenie

Column
CompanyName
Serverlp
BackupInfo
DataLoadInfo
Password
MailInfo

SweepInfo

Column
TxMillis
Called
CallID
GenielD
ReasonID

Reason

Column
UserID
UserName
LastName
FirstName
Departments
Site
CostCenters

Email
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Type

BIGINT(15)
DATETIME
DATE
VARCHAR(20)
VARCHAR(70)
VARCHAR(50)
MEDIUMINT(8)
INT(5)
BIGINT(15)

Type
VARCHAR(150)
VARCHAR(120)
TEXT

TEXT
VARCHAR(100)
TEXT

TEXT

Type
BIGINT(15)
VARCHAR(40)
BIGINT(20)
BIGINT(10)
INT(2)
VARCHAR(25)

Type
VARCHAR(70)
VARCHAR(255)
VARCHAR(50)
VARCHAR(50)
VARCHAR(100)
VARCHAR(50)
VARCHAR(100)
VARCHAR(100)

OVERVIEW
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Column

DeletedFlag

Column
TxMillis
TxDateTime
TxDate
ClientID
MessagelID
RecipientType
RecipientSite
RecipientID
RecipientName
ActionType
ActionDetail

Column
TxMillis
TxDateTime
TxDate
ClientID
EventID
EventType
Iteml
Item2
Item3
Item4
Item5
Item6
Item?7
Item8
Item9
Iteml10

Column
TxMillis
TxDateTime
TxDate
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INT(1)

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(50)
BIGINT(20)
VARCHAR(20)
VARCHAR(50)
VARCHAR(70)
VARCHAR(100)
VARCHAR(50)
TEXT

Type
BIGINT(15)
DATETIME
DATE
VARCHAR(50)
BIGINT(20)
VARCHAR(30)
VARCHAR(64)
VARCHAR(64)
VARCHAR(64)
VARCHAR(64)
VARCHAR(64)
VARCHAR(64)
VARCHAR(64)
VARCHAR(64)
VARCHAR(64)
VARCHAR(64)

Type
BIGINT(15)
DATETIME
DATE

OVERVIEW

VOCERA REPORT SERVER DATABASE SCHEMA GUIDE



Column

ClientID
DestinationType
DestinationSite
DestinationID
DestinationID
DestinationName
MessagelID
Priority
MessageText
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Type
VARCHAR(50)
VARCHAR(20)
VARCHAR(50)
VARCHAR(70)
VARCHAR(70)
VARCHAR(100)
BIGINT(20)
VARCHAR(20)
TEXT

OVERVIEW
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This chapter describes how to use Crystal Reports to create custom report definition files (*.RPT) add then
add them to the Report Console. It contains the following sections:

e Adding Custom Reports to the Vocera Report Console

e Updating the customconfig.xml File

» Configuring Report Parameters

» Step-by-Step Guide to Custom Reports

¢ Troubleshooting Problems with Custom Reports

Use the Crystal Reports designer to define a report's data source, select and group the data records to use,
and format the report. After you define a report, you can add it to the Vocera Report Console to include
with other Vocera Report Server reports.

Attention: Custom Report Server database tables are not supported. Custom database tables are not
backed up or restored after an upgrade. Vocera supports only the database tables that are installed with
Report Server.

For information about using Crystal Reports, see the separate Crystal Reports documentation.
To add a custom report to the Vocera Report Console:

1. Use Crystal Reports to define the report definition file (*.rpt).

2. Place the report definition file in the \vocera\reports\Reports\custom directory.

3. Update the customconfig.xml file to include the new report in the Vocera Report Console. See
Updating the customconfig.xml File.

4. From the Windows Start menu, select Settings > Control Panel > Administrative Tools >
Services. The Services window appears.

5. Stop the Tomcat service and then start it again.
6. Close the Services window.

The customconfig.xml file, which is located in the \vocera\reports\Reports\custom folder, specifies
the custom reports that appear in the Report Console. To add a custom report to the Report Console, you
must update customconfig.xml. You can use any XML editor to modify the file.

When you specify a custom report configuration in customconfig.xml, you must select one of the valid
report types. If you specify a report type other than “CUSTOM” (for example, “SYSTEM" or “EXPORT"),
the report is added to end of the corresponding list of standard reports in the Report Console. You cannot
create new report types or subtypes.
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The customconfig.xml file has the following XML structure:

<REPORTCONFIG>

<REPORT ID="reportId">
<NAME >< /NAME >
<DESCRIPTION></DESCRIPTION>

<FILENAME>filename.rpt</FILENAME>

<TYPE></TYPE>
<PARAMETERS>
<PARAMETER>

<DISPLAYNAME></DISPLAYNAME >

<BINDNAME></BINDNAME >

<TYPE></TYPE>

<DEFAULT></DEFAULT>
</PARAMETER>

</PARAMETERS>
</REPORT>
</REPORTCONFIG>

The customconfig.xml file uses the same XML schema as the reportconfig.xml located in the \vocera
\reports folder. The best way to become familiar with the reportconfig.xml schema is to open the

file and see how existing reports have been configured. You can copy and paste an existing report
configuration from reportconfig.xml into customconfig.xml, and then modify the configuration to add

a new report.

The following table describes the XML elements of customconfig.xml.

Table 2: customconfig.xml schema elements

Element
REPORTCONFIG
REPORT

NAME

DESCRIPTION

FILENAME

TYPE

PARAMETERS

23

Description
Root element.

A report definition.
Parameters:

e ID = report ID. The ID can be identical to the value of the NAME element. Its purpose
is merely to make the XML more readable.

Name of the report. The NAME value appears in the Vocera Report
Console.

Description of the report. The DESCRIPTION value appears below the
name of the report in the Vocera Report Console.

Report definition file. The file must be placed in the \vocera\reports
\Reports directory.

Type of report. TYPE can be any of the following values:
e SYSTEM = Summary reports

e CALL = Call reports

e DIAG = Diagnostics reports

e ASSET = Asset Tracking reports

e EXPORT = Export Data reports

e DEVICEMANAGEMENT = Device reports

e SCHEDULERDIAGNOSTICS = Scheduler Diagnostics reports

e CUSTOM = Custom reports that you create with Crystal Reports Designer.

Note: You cannot define new report types.

Parent element containing the report's parameters.

VOCERA REPORT SERVER DATABASE SCHEMA GUIDE



Element

PARAMETER

DISPLAYNAME
BINDNAME

TYPE
DEFAULT
DBLOOKUP
LOOKUP

CREATING CUSTOM REPORTS
Description

A report parameter, which appears in the Report Parameters page when
you generate the report from Vocera Report Console. Subelements
include: DISPLAYNAME, BINDNAME, TYPE, DEFAULT, DBLOOKUP,
and LOOKUP.

The name of the parameter as it appears in Vocera Report Console.

The name of the parameter in the RPT file to which this parameter is
bound.

Type of parameter (for example, TEXT or DATE).
Default value of the parameter.
Database lookup query for the parameter's values.

Defines a static lookup table for the parameter's values.

This section provides several examples showing how to define report parameters in the
customconfig.xml file. These parameters appear on the Report Parameters page when you generate the
report in the Vocera Report Console.

The following sections describe different types of report parameters:

Adding a Hidden Watermark Parameter

Adding a Text Field Parameter
Adding a Date Range Parameter

Adding a Drop-Down List Parameter

Adding Cascading Drop-Down List Parameters

Adding a Static List Parameter
Adding a Multilist Parameter

Writing SQL Queries to Define Report Parameters

The following example shows how to add a hidden watermark parameter to a report. The text of the
watermark is specified in the db.properties file using the following convention:

Watermark=WatermarkText

where WatermarkText is a string.

24

<PARAMETER>

<DISPLAYNAME >WatermarkText</DISPLAYNAME>
<BINDNAME>WatermarkText</BINDNAME>

<TYPE>HIDDEN</TYPE>
<DEFAULT>$0ptText</DEFAULT>
</PARAMETER>
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The following example shows how to display a free form Text field on the Report Parameters page:

<PARAMETER>
<DISPLAYNAME>Name</DISPLAYNAME >
<BINDNAME>UserName</BINDNAME >
<TYPE>TEXT</TYPE>

</PARAMETER>

UserName is the name of the parameter in the RPT file.

The following example shows how to display a date range field on the Report Parameters page:

<PARAMETER>
<DISPLAYNAME>Report Date</DISPLAYNAME>
<BINDNAME>ReportDate</BINDNAME >
<TYPE>DATE</TYPE>

</PARAMETER>

ReportDate is the name of the parameter in the RPT file.

The following example shows how to display a drop-down list field on the Report Parameters page. The
list is populated from the database.

<PARAMETER>
<DISPLAYNAME>Called Type</DISPLAYNAME>
<BINDNAME>CalledType</BINDNAME>
<TYPE>DROPLIST</TYPE>
<DBLOOKUP>select SiteID as code,
SiteName as description from sites</DBLOOKUP>
</PARAMETER>

CalledType is the name of the parameter in the RPT file.
Description will be displayed in the list. Code is the corresponding value for the parameter.

A cascading drop-down list is one with choices that change based on the value a user selects in another
list field. In the following example, the Owners Site drop-down list parameter is a parent of the Device
Owner drop-down list parameter.

<PARAMETER>
<DISPLAYNAME>Owners Site</DISPLAYNAME>
<BINDNAME>ownerssite</BINDNAME >Hi
<TYPE>DROPLIST</TYPE>
<DBLOOKUP>(select SiteName code, SiteName description
from sites) union (select '||||', 'All Sites' description )
Order by description</DBLOOKUP>
</PARAMETER>
<PARAMETER>
<DISPLAYNAME>Device Owner</DISPLAYNAME>
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<BINDNAME>owning</BINDNAME >A

<TYPE>DROPLIST</TYPE>

<DBLOOKUP>(select DeviceInfo.Owner as code, Groups.GroupName
as description from DeviceInfo, Groups, Sites
Where Groups.GroupID = DevicelInfo.Owner and
Groups.Site = Sites.SiteID and DeviceInfo.Owner <>
and Sites.SiteName like replace(?,'||]||"', '%%"'))union
(select '||]||', ' All Owners' description )
Order by description

</DBLOOKUP >

<PARENT>ownerssite</PARENT>

</PARAMETER>

ownerssite is the name of the parameter in the RPT file.
owning is the name of the parameter in the RPT file.
Specifies that the parent list of owning is ownerssite.

The following example shows how to display a static drop-down list field on the Report Parameters page:

<PARAMETER>
<DISPLAYNAME >Completed</DISPLAYNAME >
<BINDNAME >Accepted</BINDNAME>
<TYPE>TEXT</TYPE>
<LOOKUP>
<OPTION>
<CODE>1</CODE>
<DESCRIPTION>True</DESCRIPTION>
</OPTION>
<OPTION>
<CODE>0</CODE>
<DESCRIPTION>False</DESCRIPTION>
</OPTION>
</LOOKUP>
</PARAMETER>

Accepted is the name of the parameter in the RPT file.
The CODE element is the corresponding value for the parameter.
The DESCRIPTION element will be displayed in the list.
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The following example shows how to display a multilist field on the Report Parameters page:

<PARAMETER>
<DISPLAYNAME>Device Status</DISPLAYNAME>
<BINDNAME>status</BINDNAME>
<TYPE>MULTILIST</TYPE>
<DBLOOKUP>(select Status code,H}
Status description from devicestatus )
union (select '"|||]', ' All Device Status'
description ) Order by
description</DBLOOKUP>
</PARAMETER>

Database lookup query that returns status descriptions from the devicestatus table.

More advanced Crystal Reports users can write custom SQL queries to define reports, with WHERE clauses
that are evaluated and populated with data based on parameters that you specify. Many of the Report
Server reports are defined this way. Open the reportconfig.xml file located in the \vocera\reports
folder to see how Report Server parameters are specified.

For example, the following SQL command has a WHERE clause that references a report parameter named
DateRange_Clause:

SELECT TxDate, BadgeMacAddr, RecStatus, Score, Recognized
from RecResults WHERE {DateRange_Clause}

In this example, {DateRange_Clause} is populated by creating two report parameters, which must also be
specified in the customconfig.xml file:

o The first parameter inputs the report date as a daterange parameter (the From and Through dates).

<PARAMETER>
<DISPLAYNAME>Report Date</DISPLAYNAME>
<BINDNAME>ReportDate</BINDNAME >
<TYPE>DATE</TYPE>

</PARAMETER>

ReportDate is the name of the parameter in the RPT file.

» The second parameter is a hidden parameter that uses Vocera's $BuildClause() macro to evaluate
the expression for {DateRange_Clause} as (RecResults.TxDate >= ReportDate.Lowerbound and
RecResults.TxDate <= ReportDate.Upperbound).

The $BuildClause() macro is used to build a WHERE clause for a SQL query. It takes the following
arguments:

¢ Column name in the SQL to bind
e Name of the input parameter
e Operation. Specify any of the following operations:

» daterange: Used to generate Date range expressions. [ column > lowerbound and column <
upperbound |

* stringequals: Used to generate an expression for Text parameters [ column = parameter value ]
e list-in: Used to generate expressions for MultiList parameters [ column in (P1, P2, P3) ]
Here is an example of a hidden parameter with the $BuildClause() macro:

27
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<PARAMETER>
<DISPLAYNAME>Hidden Where Clause</DISPLAYNAME>
<BINDNAME>DateRange_Clause</BINDNAME >
<TYPE>HIDDEN</TYPE>
<DEFAULT> $BuildClause(RecResults.TxDate, ReportDate,
daterange)</DEFAULT>
</PARAMETER>

This section provides step-by-step tutorials on how to create custom reports for Report Server. You can
follow these basic steps to create your own reports or modify the standard Vocera reports.

Crystal Reports allows you to create reports using several different methods. You can build reports from
scratch, or you can use the four Report Creation wizards, which provide a series of screens to help you
define a report.

This section assumes you are familiar with Crystal Reports. For more in depth coverage of Crystal Reports
features, see the Crystal Reports 2008 User's Guide.

Before starting these tutorials, prepare your Crystal Reports computer:

e Make sure you have copied the Vocera report files (*.RPT) from the Report Server computer to your
Crystal Reports designer computer. The files are located in the \vocera\reports\Reports folder.

» Install the MySQL Connector/ODBC 3.51 driver, and set up an ODBC data source to connect to your
Vocera Report Server. See Installing Crystal Reports 2008 and MySQL Connector/ODBC 3.51.

This section has the following step-by-step tutorials:

¢ Creating a Custom Report from a Standard Report
¢ Creating a Custom Report from a SQL Query

This tutorial shows how to save one of the standard Vocera reports, the Broadcasts report, as a new report
and then modify it. This is the quickest way to use Crystal Reports designer to create a custom report.

To modify a standard Vocera report:

1. In Crystal Reports, choose File > Open. The Open dialog box appears.
2. Navigate to the folder where Vocera reports are saved, and select Broadcasts.rpt. Click Open.
The Broadcasts to Groups report opens in the Crystal Reports designer:
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3. Choose File > Save As. Save the file as BroadcastsCustom.rpt.

4. Choose View > Field Expolorer.In the Field Explorer, expand the Database Fields to show the
Broadcasts table.

5. Expand the Broadcasts table. Click and Drag the UserType field into the Details section of the report
between UserName and CostCenters. Resize the fields to fit them on the report.

6. Choose File > Save to save the report.

7. Copy the BroadcastsCustom.rpt file to the \vocera\reports\Reports\custom folder on the Report
Server computer.

Now you are ready to add the report to the customconfig.xml file.

8. On the Report Server computer, navigate to the \vocera\reports\Reports\custom folder and open the
customconfig.xml file in a text editor.

9. Add the following new report configuration to customconfig.xml. This configuration is nearly the
same as the existing one for the existing Broadcasts report. You can copy it from reportconfig.xml,
which is located in the \vocera\reports folder. You should make changes only to to the following
elements in the configuration and save.

<REPORT ID="BroadcastsCustom">
<NAME>Custom Report - Broadcasts</NAME>
<DESCRIPTION>This report shows which groups are
receiving Broadcasts.</DESCRIPTION>
<FILENAME>custom/BroadcastsCustom.rpt</FILENAME>
<TYPE>CUSTOM</TYPE>

There are many different parameters in this report configuration. For information about each type of
parameter, see Configuring Report Parameters.

10.From the Windows Start menu, select Settings > Control Panel > Administrative Tools >
Services. The Services window appears.

11.Stop the Tomcat service and then start it again.
12.Close the Services window.

13.Log into the Report Console.

14 Click Custom Reports.
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15Select Custom Report - Broadcasts and then click Generate.
The Report Parameters page appears.
16.Specify the report date range and site, and then click Generate.
The report should look like the following screen.

vocera’

COMMUNICATIONS

CREATING CUSTOM REPORTS

4/1/06 - 5/23/06

Broadcasts to Groups

Site: North Little Rock

Case Coordination

Date / Time User UserType Cost Centers Duration (Secs)
4/6/06 6:43:59AM Danner, Tamara User g
5M7I06 10:57:25AM Hart, Bill User 2008323 25
Total Broadcasts: 2 Average Duration: 16 Seconds
Housekeeping

Date / Time User UserType Cost Centers Duration (Secs)
4/7/06 5:38:34AM Services Two, Linen User 42 17
4/7106 6:01:34AM Weiland, Liz User 12
4/7106 7:24:55AM Services, Trash User 15
417106 11:31:584M Services Two, Linen User 42 16
4/19/06 4:55:534M Services Two, Linen User 42 9
4/21/06 4:54:454M Services Two, Linen User 42 25
4/21/06 5:08:05AM Senvices Two, Linen User 42 7
4/21/06 7:05:07AM Senvices Two, Linen User 42 49
4121/06 712:39AM Senvices Two, Linen User 42 12
412106 9:49:21AM Senvices Two, Linen User 42 10
4124/06 8:39:2TAM Wieiland, Liz User 33
4/24/06 11:22:21AM Weiland, Liz User 19
4124/06 11:35:50AM Lawrence, Shirley User 14
4124/06 1:0711FPM Lawrence, Shirley User 9
4/26/06 6:45:.04AM Weiland, Liz Uszer 40
4127106 7:31:34AM Services Two, Linen User 42 5
427106 12:58:55PM Lawrence, Shirley User 23
4/30/06 9:48:404M Weiland, Liz User 12
4/30/06 10:49:13AM Weiland, Liz User 1
4130/06 11:14:39AM Housekeeper, Second Floor User 8
BI6I06 6:54:17FM Housekeeper, Second Floor User 5
BMGI06 7:02:19AM Lawrence, Shirley User 17
Total Broadcasts: 22 Average Duration: 17 Seconds
Linen Services

Date / Time User UserType Cost Centers Duration (Secs)
4/24/06 §:48:46AM Wieiland, Liz User 10

Total Broadcasts: 1

Average Duration: 10 Seconds

This tutorial shows how to create a report from scratch using a SQL query. It is for more sophisticated
users who are both familiar with the Crystal Reports designer and experienced with SQL. The tutorial
explains how one of the standard Report Server reports, the Inactive Users report, was created. You can
use the steps from this tutorial to create your own reports.

To create a custom report from scratch using a SQL query:

1. In Crystal Reports, choose File > New > Blank Report. The Database Expert dialog box appears.
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B patabase Expert

Data |

Browse the data source for the tables you want to add.

[Mote: to edit the alias for a table, select the table in the 'Selected T ables' tree and click on it o

press the F2 key]
Buailable Data Sources: Selected Tables:

=10l x|

B+ Create New Cornection
- Repositon

L

0K I Cancel

Help

CREATING CUSTOM REPORTS

2. In the Available Data Sources box, open the Create New Connection folder, and then open the

3. Select VoceraReports, and then click Next.
The Connection Information dialog box appears.
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ODBC (RDO) folder.

The Data Source Selection dialog box appears.

Data Source Selection
Choose a data source from the list or open a file dsn from the browse

buttan
Select Data Source: o
[rata Source Mame: dBASE Files
Excel Files
M5 Access Database
“izio D atabaze Samples
oceraR eports
#ireme Sample Databaze 11
Find File DSM: e
File DSN: [ [
Enter Connection String: i

Connection String: I

< Back I Mext » I Finizh Cancel

Help
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ODBC (RDO) 3
Connection Information
Provide necessary information to log on ta the chosen data source
Server “YoceraFeports
Uszer ID: |
Password:
[ratabaze: wocera_reports w
Finizh ] [ Cancel ] [ Help

4. For both the User ID and Password fields, enter "vocera". Click Finish.
The Connection Information dialog box closes, leaving the Database Expert.

5. In the VoceraReports folder, double-click Add Command. The Add Command To Report dialog box
appears.

Enter 5QL query in the box below,

E: Add Command To Report

. i

[ Parameter List

=] Create...
Iodifiy...
Remove

OF Cancel

6. Enter the following SQL command in the box. This is the SQL command for the Inactive Users report:

select * from users, sites where users.site=sites.sitelD
and users.deletedflag = © and userid not in (select
Distinct UserID from Inventory force index(idx_TxDate)
where {?DateRange Clause}) and “UserID” <> ' NLI '
and “UserID <> '__ PHONE__ "' and

{?Site_Clause} and

{?Dept_Clause}

In the Parameter List box, click Create. The Command Parameter dialog box appears.
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Command Parameter

x|
Ok
Parameater Mame —I

I Cancel

Frompting Test

Yalue Type

I String hd I
Default Value

CREATING CUSTOM REPORTS

7. In the Parameter Name field, enter DateRange_Clause. In the Value Type field, select String. For

Default Value, enter 1=1.
Click OK.

8. Create parameters for Dept_Clause and Site_Clause. They are also String parameters whose default

value is 1=1.

9. Click OK in the Add Command to Report dialog box.

The Enter Values page appears.

K Enter Values

DateRange_Clause

I =

Enter a Walue:

Dept_Clause

I~ =

Enter a ‘alue:

Site_Clause

[ =

Enter a Yalue:

DateRange_Clouse

Dept_Clause

Site_Clause

N ———.

E

10Select 1=1 for each value, and then click OK.

The Enter Values page closes, returning to the Database Expert. In the Selected Tables box, a new
Command table is listed under VoceraReports. This is the SQL command you just created.

11 Select the Command table, and press F2. Change the name of the table to Inactive.
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B patabase Expert

Data |

Browse the data source for the tables you want to add.

[Mote: to edit the alias for a table, select the table in the 'Selected T ables' tree and click on it o

press the F2 key]
Buailable Data Sources:

B[] Favorites ;I
- History
I_::_| (C]Create Mew Connection
- [ éccess/Excel DAD)
Databaze Files
Exchange 5.5 Message
Exchange Message Tra
Legacy Exchangs
Mailbow Adrmin
ODBC (RDO)
-4 Make New Connect
8; WoceraReports

] &dd Command
vocera repoits ¥

*

" =

e

Selected Tables:

=10l x|

[ - VoceiaReports

0K I Cancel

Help

Click OK.

CREATING CUSTOM REPORTS

12 Now you need to specify how the fields should be grouped in the report. Choose Report > Group

Expert.

The Group Expert dialog box appears.
13In the Available Fields box, select the Inactive.Site field, and then click the > | button to move it to

the Group By box.

Select the Inactive.Departments field, and click the > | button again.

% Group Expert

Available Fields:

EE Userklame ;I
B3 Lasthame

= Firsthame

= Depattments

= Site

= CostCenters

2= Emal

.3 DeletedFlag(1)

Browse Data... Find Field. .. I

i EE

=

<

Graup By: +

E Inactive Site - A
H E Inactive.Depattments - &

Options... |

0K | Cancel | Help

Click OK.

14 In the Field Explorer, expand Inactive table and insert the UserID, LastName, and FirstName fields into

the report.

Afterward, the designer should look like this:

Desian | il WA
e \ 1 gz a g g P
Repart Header
Frealbimit ,
. |usenp o FirstMame o LasiName
Group Header #1 roup #1 Name
Group Header #2: _._Group #2 Name
Details 581D Firsthame LastMame

Giouo Footer #2

Grouo Footer #1

Fiepart Footer

Page Faater
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15 Now let's also apply a Vocera template to the report. Choose Report > Template Expert. The

Template Expert dialog box appears.

Ei Template Expert x|

' Apply & new templates

Available Templates Preview

Mo Templake

Block {Blue)

Confidential Underlay
Cotporate - Page Sections Cnly
Corporate (Blug)

Cotporate (Green)

Double-Sided Page Headers/Footers
Executive Summary or Title Pags
Form {Maroon)

Gray Scale

High Conkrast

Contrast Index

Table Grid Template

Wiane

Erowse...

€ Undo the cunent template

{71 Be-apply the [ast template

QK I Cancel Help

16.Click Browse. In the Open dialog box, navigate to the folder where Vocera standard reports are located.
On the Report Server, the reports are installed in \vocera\reports\Reports.

17 Select the report named VoceraReportTemplatePortrait.rpt, and then click OK.

=== Note:

Vocera also provides a template for landscape format named
VoceraReportTemplatelLandscape.rpt.

18 Insert text objects in the Group Footer #2, Group Footer #1, and Report Footer to provide a count of
inactive users for groups and for the report. Afterward, the designer should look like this:

Design [ Preview | TR N A
5 ' 1 gz ' 3 g4 [
Report Header .
Page Header 2 wvocera’
. COMMUNICATIONS
Page Header b . N
- {Report Title}
Group Header #1 _. _Group #1 Name
_
Groun Header #2: _._Group #Z Name
Detais — UserD FirstName LastName
Grouo Footer H2: . [Totallnactive Users for Department: {Count of Inactive. UserlD)
Grouo Footer #1 _ [Totallnactive Users for Site: {Count of Inactive UserlD}
Repart Faoter . :I'nta\ Inactive Users: (Count of Inactive.User D} N
face hoole - Printoatey .. UsenD

19.In the Field Explorer, right-click Parameter Fields and choose New from the popup menu.
The Create New Parameter dialog box appears.
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Ereate New Parameter ﬂ

Marne:

I DateRange

List of Yalues:

' Skatic " Dynamic

‘Walue Field Description Field
I (Mone) j I {Mone) j
[ Insert | 4 ¥ |Actions v
Walue Description
Click here ko add item
Options:
Option Setting -
Prompt Texk Enter DateRange:
Prompt With Description Only False
Default Value
Allow custom values True
Allove multiple values False
Allow discrete values True LI

oK I Cancel | Help |

CREATING CUSTOM REPORTS

20.In the Name field, type DateRange. For the Type field, select Date. In the Options list, scroll down
until you see the Allow Range Values option. Change its setting to True. Click OK.
Note: If you fail to change the setting of Allow Range Values to True, you will be unable to run the

report. See Troubleshooting Problems with Custom Reports
21.Add another parameter called CompanyName whose type is String.

22.Choose File > Summary Info. The Document Properties dialog box appears.
23 In the Title field, enter Inactive Users Report.

Enter values in other fields as you choose, such as Author and Subject, and then click OK.
24 Format the report to improve its look. Afterward, it should look like this:

Design

Reoort Header

23K L]
IR 2o 1 ca - 5o em -

o o s ' o
L i o i)
occera

Page Header a

COMMUNICATIONS @DateRangeTitle

Page Header b

- {Report Title}

Page Header o

eport Comments

%

Page Header d
Pt MIGroup # ame

Giroup Header Group #2 Name

Inartive Nenartments - & r

Group Header #2b: [ serlD First Name [ast Name
Details I DsenD . Firsibame . LastMame

Group Fater #2
Inactive Depariments - &

o Total Inactive Users for Department: {Count of Inactive.UseriD}

Gioup Footer #1
Inactive. SiteName - A&

_ | Tetal Inactive Users for Site: {Count of Inactive.UserID}
v

Fepoit Footer

©| Total Inactive Users: {Count of Inactive.UserlD}

Page Footer

:
- [ {Print Date) . ?CompanyName b Fage N of M,

25.Choose File > Save to save the report. Save the report as CustomInactiveUsers.rpt.

26.Copy the CustomInactiveUsers.rpt file to the \vocera\reports\Reports\custom folder on the
Report Server computer.

Now you are ready to add the report to the customconfig.xml file.

27.0n the Report Server computer, navigate to the \vocera\reports\Reports\custom folder and open the
customconfig.xml file in a text editor.
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28.Add the following new report configuration to customconfig.xml. You do not need to type this text.
Instead, you can copy the Inactive Users report configuration from reportconfig.xml, which is
located in the \vocera\reports folder. You should make changes only to to the following elements in

the configuration and save.

There are many different parameters in this report configuration. For information about each type of

parameter, see Configuring Report Parameters.

<REPORT ID="Custom Inactive Users">

<NAME>Custom Report - Inactive Users</NAME>

<DESCRIPTION>This report shows the users who have not
used the Vocera System during the specified date

range.</DESCRIPTION>

<FILENAME>custom/CustomInactiveUsers.rpt</FILENAME>

<TYPE>CUSTOM</TYPE>

29 From the Windows Start menu, select Settings > Control Panel > Administrative Tools >
Services. The Services window appears.

30.Stop the Tomcat service and then start it again.

31.Close the Services window.
32Log into the Report Console.
33 Click Custom Reports.

34 Select Custom Report - Inactive Users and then click Generate.

The Report Parameters page appears.

35.Specify the report date range, site, and department(s), and then click Generate.

The report should look like the following screen.

vocera’

COMMUNICATIONS

71/2008 - 711772008

Inactive Users Report

recognition.

No Department Assigned
UserlD

First Name

This report displays users entered in to the Vocera System that have not used the systemn during the supplied
date range, grouped by Sites, then Depantments. Removing unused names from the system may improve name

Site: Bay

Last Name

1400
2100
2045
2094
2N
2806
1814
2045
112

Stan
Pat
Jim
Elka
Sam
Don
Mari
Jess
Brian

Allan
Arron
Bartlet
Bizhaop
Borer
Boscam
Bosko
Bow
Bowe

For custom reports to run successfully, you should have executed the following tasks correctly:

» Define the report correctly, which involves selecting the right data source, defining the parameters, and

applying the report template.

» Copy the *.rpt file to the correct location on the report server.
» Add the new report configuration to the customconfig.xml file and configure all the root elements and

parameters correctly.
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The following are common problems encountered while running custom reports:

Table 3: Troubleshooting Problems with Custom Reports

Problem

The report fails to generate, or you are prompted
to install Adobe Flash player.

When you generate a custom report and specify
the report parameters, the report fails to
generate and an HTML dialog box prompts for
missing report parameters.

38

Solution

You have misconfigured a report parameter in the RPT file. To
fix this problem, open the rpt file in the Crystal Reports, confirm
the values defined for each parameter are correct. For example,
if the report has a DateRange parameter, make sure the 'Allow
Range Values' option for the parameter is set to TRUE.

You have omitted parameters for the report in the
customconfig.xml file. To fix the problem, edit the
customconfig.xml file and configure all the parameters defined
in the report.
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The following topics provide details about the structure and contents of tables of Vocera usage data
maintained in the Vocera Report Server database. The tables are listed in alphabetical order; columns are

listed according to their position in each table.

39

addressbookentries on page 40
audit on page 40

broadcasts on page 41

calls on page 42

deviceinfo on page 43
devicestatus on page 44
devicestatuschange on page 44
dnd on page 45

failures on page 45
groupactivity on page 46
groupconference on page 47
groups on page 48
incompletedata on page 48
inventory on page 49
locations on page 49
loginlogout on page 50
lostconnectiondetail on page 50
lostconnectionlog on page 51
messageactivity on page 52
posted on page 53
radiodetail on page 53
radiolog on page 54
recresults on page 55

sites on page 56

speechports on page 56
systeminfo on page 57
unansweredcalls on page 58
users on page 58

vmiactions on page 59
vmievent on page 60
vmimessages on page 61
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DATABASE DETAILS

====| Note: For instructions on how to set up an ODBC data source to connect to your Report Server
database, see Installing Crystal Reports 2008 and MySQL Connector/ODBC 3.51.

The addressbookentries table stores data about Address Book Entries that can be entered and edited
via the Address Book screen in the Vocera server Administration Console. This table has a primary key
consisting of the following columns: FirstName, LastName, Site and Type.

Table 4: addressbookentries table

Column Description

LastName varchar(50) NOT NULL default '@’

The LastName column specifies the last name for the entry, if the entry type is Person. If the entry type is
Place, the value is an empty string.

FirstName varchar(50) NOT NULL default '@’

The FirstName column specifies the first name for the entry, if the entry type is Person. If the entry type is
Place, the value is the name of the Place.

Type varchar(50) NOT NULL default ''
The Type column specifies the entry type: Person or Place.
Site varchar(50) NOT NULL default "'
The Site column specifies the Vocera site for which the entry is defined.
Phone varchar(50) NOT NULL default "'
Specifies the phone number.
Pager varchar(50) NOT NULL default ''
Specifies the pager number.
DeletedFlag int(1) unsigned zerofill default '0’

The DeletedFlag column indicates whether an entry has been deleted (0 = false).

Although the entity may be flagged as deleted, it is not purged from the database because historical data
(that is, older report logs) may continue to reference it.

The audit table stores data about changes made to the Vocera system. This table has a primary key based
on the TxMillis column.

Table 5: audit table

Column Description

TxMillis bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

TxDateTime datetime NOT NULL default '0000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.
TxDate date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.
UserID varchar(70) default NULL

The UserID column specifies the user ID of the person who made the change. This value corresponds to
a User ID specified via the Administration Console or the User Console on the Vocera server, unless the
user logged in with the built-in login ID Administrator, in which case this value is _ NONE__. Or, if the
operation was performed automatically by the Vocera system, for example, an automated restore of the
database, this value is null. See LoginId.

UserSite varchar(50) NOT NULL default '’

In a multi-site installation, the UserSite column specifies the Vocera site with which the user is associated.
In a single-site installation, this value is null.
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Column

LoginId

Operation

ModifiedEntityType

ModifiedEntityID

DATABASE DETAILS

Description

varchar(50) default NULL

The LoginId column specifies the login ID of the person who made the change. This value corresponds to a
User ID specified via the Administration Console or the User Console on the Vocera server, unless the user
logged in with the built-in login ID Administrator, in which case this value is Administrator. See UserID.

varchar(30) NOT NULL default "'

The Operation column specifies the operation that changed the Vocera database. Sample values include:
Backup, Update, Create, and Update Conference Group.

varchar(20) NOT NULL default "'

The ModifiedEntityType column specifies the type of the entity that was changed. Sample values include:
AddrBook, Group, and User.

varchar(70) NOT NULL default ''

The ModifiedEntityID column identifies the entity that was changed. For a user, the value is the user ID.

For a group, the value is the group name. For an address book entry, the value is the address book entry

name. If the Vocera database was not changed, for example, when a Backup operation occurs, this value is
NONE_ .

The broadcasts table stores data about broadcasts made to Vocera groups. This table has a primary key
based on the TxMillis column.

Table 6: broadcasts table

Column

TxMillis

TxDateTime

TxDate

UserType

UserlID

UserSite

GroupName

GroupSite

Duration

IdBroadcast

4]

Description

bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '©000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.

date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.

varchar(20) NOT NULL default "'

The UserType column specifies which type of user initiated the broadcast. Example values: User, Phone

varchar(70) default NULL

The UserID column specifies the user ID of the person who initiated the broadcast. This value corresponds
to a User ID specified via the Administration Console or the User Console on the Vocera server.

varchar(50) default NULL

In a multi-site installation, the UserSite column specifies the Vocera site with which the user is associated.
In a single-site installation, this value is null.

varchar(50) default NULL

The GroupName column specifies the Vocera group to which the broadcast was sent.

varchar(50) default NULL

In a multi-site installation, the GroupSite column specifies the Vocera site associated with the group to
which the broadcast was sent. In a single-site installation, this value is null.

bigint(15) unsigned NOT NULL default '@’

The Duration column specifies the duration of the broadcast in seconds.

bigint(15) unsigned NOT NULL default '@’

The IdBroadcast column identifies a Vocera broadcast. However, this value is not guaranteed to be unique.
Any given broadcast could have the same IdBroadcast value as another broadcast that took place earlier or
later. One way to distinguish broadcasts is to compare values in the TxMillis column.
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Column

IdGenie

DATABASE DETAILS

Description

bigint(15) unsigned NOT NULL default '@’

The IdGenie column identifies a Genie session. A single Genie session may comprise several events. For
example, a Genie session for a badge-to-badge call may include the "Vocera" prompt played on the calling
party's badge and the "Can you talk to ..." prompt played on the called party's badge.

In the table, rows for events in the same Genie session have the same value in the IdGenie column.
However, this value is not guaranteed to be unique. Any given Genie session could have the same IdGenie
value as another Genie session that took place earlier or later. One way to distinguish Genie sessions is to
compare values in the TxMillis column.

The calls table stores data about calls placed and received through the Vocera system. This table has a
primary key based on the TxMillis column.

Table 7: calls table

Column

TxMillis

TxDateTime

TxDate

UserType

UserlID

UserSite

CalledType

Called

CalledName

CalledSite

Accepted

AcceptedByType

AcceptedBy

42

Description

bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '©000-00-00 00:00:00'

The TxDateTime column stores the date and time of the event, accurate to the second.

date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.

varchar(20) NOT NULL default '’

The UserType column specifies which type of user initiated the call. Example values: User, Phone

varchar(70) default NULL

The UserID column specifies the user ID of the person who initiated the call. When the UserType value is
User, this value corresponds to a User ID specified via the Administration Console or the User Console on
the Vocera server. When the UserType value is Phone, this value is the literal string _ PHONE__.

varchar(50) default NULL

In a multi-site installation, the UserSite column specifies the Vocera site with which the calling party is
associated. In a single-site installation, this value is null.

varchar(10) NOT NULL default "'

The CalledType column specifies which type of user was the called party. Example values: User, Group,
Phone

varchar(40) NOT NULL default '’

The Called column specifies the User ID, Group Name, or Phone Number of the called party, depending on
the CalledType value.

varchar(100) default NULL

The CalledName column specifies the name of the called party, if the CalledType is User. If the CalledType
is Group or Phone, the value is null.

varchar(50) default NULL

In a multi-site installation, the CalledSite column specifies the Vocera site with which the called party is
associated. In a single-site installation, this value is null.

int(1) NOT NULL default '@

The Accepted column specifies whether a call was accepted by the called party. The value is 1 if the call
was accepted; otherwise, the value is 0.

varchar(10) default NULL

The AcceptedByType column specifies which type of user accepted a call. If a call was not accepted, this
value is null. Example values: User, Phone

varchar(40) default NULL

The AcceptedBy column specifies the User ID or Phone Number of the party who accepted a call, depending
on the value of the AcceptedByType column.
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Column

AcceptedByName

AcceptedBySite

DeviceType

Duration

IdCall

IdGenie

DATABASE DETAILS

Description

varchar(100) default NULL

The AcceptedByName column specifies the User Name of the party who accepted a call, if the AcceptedBy
value is a User ID. If the value of AcceptedBy is a Phone Number or the literal string value _ NONE__,
AcceptedByName is null.

varchar(50) default NULL

In a multi-site installation, the AcceptedeBySite column specifies the Vocera site with which the accepting
party is associated. In a single-site installation, this value is null.

varchar(64) default NULL

Device type that initiates a call. Possible values: B1000, B1000A, B2000, B3000, MC70, and Smartphone. If
you have deployed Vocera Connect, other possible values are Cisco, Apple, and Android.

bigint(15) unsigned NOT NULL default '@’

The Duration column specifies the duration of the call in seconds.

bigint(20) NOT NULL default '@’

The IdCall column identifies a call placed or received through the Vocera system. However, this value is not
guaranteed to be unique. Any given call could have the same IdCall value as another call that took place
earlier or later. One way to distinguish calls is to compare values in the TXDateTime column.

bigint(10) NOT NULL default '@’

The IdGenie column identifies a Genie session. A single Genie session may comprise several events. For
example, a Genie session for a badge-to-badge call may include the "Vocera" prompt played on the calling
party's badge and the "Can you talk to ..." prompt played on the called party's badge.

In the table, rows for events in the same Genie session have the same value in the IdGenie column.
However, this value is not guaranteed to be unique. Any given Genie session could have the same IdGenie
value as another Genie session that took place earlier or later. One way to distinguish Genie sessions is to
compare values in the TxMillis column.

The deviceinfo table stores data about Vocera devices, such as badges. This table has a primary key based
on the BadgeMacAddr column.

Table 8: deviceinfo table

Column

DevicelD
BadgeMACAddr
SerialNo

Label

Type

Color

Owner

Site

TrackingDate
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Description

varchar(20) default NULL
Specifies the device ID from the Vocera Server. Example value: D-0009ef050686

varchar(12) NOT NULL
Specifies the badge MAC address. Example value: 0009ef006e9a

varchar(20) default NULL

Specifies the badge serial number.

varchar(30) default NULL

Specifies the device label.

varchar(15) default NULL
Specifies the device type. Possible values: B1000A, B2000, B3000, MC70, or Smartphone.

varchar(20) default NULL

Specifies the device color.

varchar(50) default NULL

Specifies the device Owner group.

varchar(50) default NULL

Specifies the device Site.

date default NULL

The tracking date of the device.

Note: This field can be any date used to track a device, for example, the date it was sent for repair
or RMA'ed.
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Column

BadgeUsage

Notes

DeviceCode

FirmwareVersion

LastStatus

LastUser

LastLocation

LastAccessed

InternalSerialNo

DATABASE DETAILS

Description

tinyint(1) default NULL

Indicates whether the badge is shared or nonshared. 1 = shared, 0 = nonshared.

text

Notes describing the device.

int(5) default '@’

Specifies the badge device code. Possible values: -1 = B1000 badge, 0 = B1000A badge, 2 = B2000
badge

Note: This is a legacy data field that is no longer used by standard Report Server reports.

int(5) default '@’
Specifies the badge firmware version.

varchar(50) default NULL

Specifies the last status of the device.

varchar(70) default NULL

Specifies the last user of the device.

varchar(50) default NULL

Specifies the last location of the device based on the access point it connected with.

timestamp NULL default NULL

The timestamp when the device last access the Vocera Server.

varchar(20) default NULL

The serial number provided by the device. This value can be used to validate the serial number
entered by a user.

The devicestatus table stores data for device statuses. This table has a primary key based on the Status

column.

Table 9: devicestatus table

Column

Status

Description

DeletedFlag

Description

varchar(100) NOT NULL

The device status.

text

A description of the device status.

int(1) unsigned zerofill default '@’

Indicates whether a device status has been deleted (0 = false, 1 = true).

Although the entity may be flagged as deleted, it is not purged from the database because historical data
(that is, older report logs) may continue to reference it.

The devicestatuschange table stores data for device statuses that have been changed by users. This table
has a primary key based on the TxMillis column.

Table 10: devicestatuschange table

Column

TxMillis

TxDateTime

44

Description

bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '0000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.
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Column Description
TxDate date default NULL
The TxDate column stores the date of an event, accurate to the day.
DevicelD varchar(20) NOT NULL
Specifies the device ID from the Vocera Server. Example value: D-0009ef050686
DeviceSite varchar(50) NOT NULL
Specifies the site of the device when the status changed.
Status varchar(30) NOT NULL
Specifies the device status.
Notes text

Notes describing the device status.

The dnd table stores data about when users turn Do Not Disturb (DND) mode on or off. This table has a
primary key based on the TxMillis column.

Table 11: dnd table
Column Description

TxMillis bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

TxDateTime datetime NOT NULL default '0000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.
TxDate date default NULL

The TxDate column stores the date of an event, accurate to the day.
UserID varchar(70) default NULL

Specifies the user ID of the person who turned DND mode on or off. This value corresponds to a User ID
specified via the Administration Console or the User Console on the Vocera Server.

UserSite varchar(50) default NULL

In a multi-site installation, the UserSite column specifies the Vocera site with which the user is associated.
In a single-site installation, this value is null.

DND int(1) default null

Whether the user turned DND mode off or on; 0 means off and 1 means on.

The failures table stores data about badge software failures. This table has a primary key based on the
TxMillis column.

Table 12: failures table
Column Description

TxMillis bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

TxDate date default NULL
The TxDate column stores the date of an event, accurate to the day.
TxDateTime datetime NOT NULL default '0000-00-00 00:00:00'

The TxDateTime column stores the date and time of the event, accurate to the second.

45 VOCERA REPORT SERVER DATABASE SCHEMA GUIDE



Column

UserID

UserSite

BadgeMACAddr

Failuretext
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Description

varchar(70) default NULL

The UserID column specifies the user ID of the badge user, if a user was logged in to the badge. If no user
was logged in to the badge at the time of the failure, this value is the literal string  NLI .

varchar(50) default NULL

In a multi-site installation, the UserSite column specifies the Vocera site with which the badge is
associated. In a single-site installation, this value is null.

varchar(12) default NULL
The BadgeMACAddr column specifies the badge's MAC address. Example value: 0009ef0078a3

varchar(50) NOT NULL default "'

The Failuretext column stores text describing the failure. Example value: Failure in pre.c at line 166. Code:
0009

The groupactivity table stores data about changes to Vocera groups when members are added or removed.
This table has a primary key based on the TxMillis column.

Table 13: groupactivity table

Column

TxMillis

TxMillis

TxDate

UserType

UserlID

UserSite

Operation

GroupName

GroupSite

PartyID

PartySite
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Description

bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '©000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.

date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.

varchar(20) NOT NULL default ''

Specifies which type of user who initiated AddToGroup and RemoveFromGroup. Example values: User,
Phone

varchar(70) default NULL

Specifies the user ID of the person who initiated AddToGroup and RemoveFromGroup. This value
corresponds to a User ID specified via the Administration Console or the User Console on the Vocera Server.

varchar(50) default NULL

In a multi-site installation, the UserSite column specifies the Vocera site with which the user is associated.
In a single-site installation, this value is null.

varchar(64) NOT NULL default ''

Specifies the operation, either addtogroup or removefromgroup.

varchar(50) default NULL

Specifies the Vocera group to which the party was added ot from which the party was removed.

varchar(50) default NULL

In a multi-site installation, the GroupSite column specifies the Vocera site associated with the group whose
membership was modified. In a single-site installation, this value is null.

varchar(70) default NULL

Specifies the user ID of the person who was added to or removed from the group. This value corresponds to
a User ID specified via the Administration Console or the User Console on the Vocera Server.

varchar(50) default NULL

In a multi-site installation, the PartySite column specifies the Vocera site with which the user who was
added to or removed from the group is associated. In a single-site installation, this value is null.
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Description

bigint(15) unsigned NOT NULL default '@’

The IdGenie column identifies a Genie session. A single Genie session may comprise several events. For
example, a Genie session for a badge-tobadge call may include the "Vocera" prompt played on the calling
party's badge and the "Can you talk to..." prompt played on the called party's badge.

In the table, rows for events in the same Genie session have the same value in the IdGenie column.
However, this value is not guaranteed to be unique. Any given Genie session could have the same IdGenie
value as another Genie session that took place earlier or later. One way to distinguish Genie sessions is to
compare values in the TxMillis column.

The groupconference table stores data about group conferences, which are also called instant conferences.
This table has a primary key based on the TxMillis column.

Table 14: groupconference table

Column

TxMillis

TxMillis

TxDate

UserType

UserlID

UserSite

GroupName

GroupSite

Duration

IdGroupConf

IdGenie
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Description

bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '©000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.

date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.

varchar(20) NOT NULL default '’

Specifies which type of user initiated the group conference. Example values: User, Phone

varchar(70) default NULL

Specifies the user ID of the person who initiated the group conference. This value corresponds to a User ID
specified via the Administration Console or the User Console on the Vocera Server.

varchar(50) default NULL

In a multi-site installation, the UserSite column specifies the Vocera site with which the user is associated.
In a single-site installation, this value is null.

varchar(50) default NULL

Specifies the Vocera group to which the group conference was sent.

varchar(50) default NULL

In a multi-site installation, the GroupSite column specifies the Vocera site associated with the group to
which the group conference was sent. In a single-site installation, this value is null.

bigint(15) unsigned NOT NULL default '@’

Specifies the duration of the group conference in seconds.

bigint(15) unsigned NOT NULL default '@’

Identifies a Vocera group conference. However, this value is not guaranteed to be unique. Any given group
conference could have the same IdGroupConf value as another group conference that took place earlier or
later.

bigint(15) unsigned NOT NULL default '@’

The IdGenie column identifies a Genie session. A single Genie session may comprise several events. For
example, a Genie session for a badge-tobadge call may include the "Vocera" prompt played on the calling
party's badge and the "Can you talk to..." prompt played on the called party's badge.

In the table, rows for events in the same Genie session have the same value in the IdGenie column.
However, this value is not guaranteed to be unique. Any given Genie session could have the same IdGenie
value as another Genie session that took place earlier or later. One way to distinguish Genie sessions is to
compare values in the TxMillis column.
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The groups table stores data about Vocera groups. This data can be entered and edited via the Groups
screen in the Vocera server Administration Console. This table has a primary key based on the GroupID
column.

Table 15: groups table

Column Description
GroupID varchar(70) default NULL
Specifies the internal ID of a group.
GroupName varchar(50) NOT NULL default '@’
The GroupName column specifies the name of a group. Example values: Code Blue Group, Facilities
Site varchar(50) NOT NULL default "'

The Site column specifies the Vocera site with which a group is associated. In a single-site installation, this
value is the literal string s-global.

CostCenter varchar(100) default NULL
The CostCenter column stores a value that identifies the group's cost center (typically used for accounting
purposes).

DeletedFlag int(1) unsigned zerofill default '@’

The DeletedFlag column indicates whether an entry has been deleted (0 = false).
Although the entity may be flagged as deleted, it is not purged from the database because historical data
(that is, older report logs) may continue to reference it.

UserMembers mediumtext default NULL
Stores the user members of the group. The values are separated by a vertical bar ( | ).
Department varchar(50) default NULL

Stores the group's department. A group can have only one department or none.
group P group Y P

The incompletedata table stores data generated when a log file does not contain all the events of a Vocera
transaction. For example, suppose a badge user initiates a call just before midnight and doesn't end the
call until after midnight. Because Vocera automatically creates a new log file at midnight, the events for
this call would be spread over two log files, and would end up in the incompletedata table when the Report
server parses the Vocera server logs.

Incomplete data may also be generated if the log file stores more than 10,000 entries, or if the server is
restarted while a transaction is in progress. This table has a primary key based on the TxMillis column.

Table 16: incompletedata table

Column Description

TxMillis bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

TxDateTime datetime NOT NULL default '0000-00-00 00:00:00'
The TxDateTime column stores the date and time of the event, accurate to the second.
Type varchar(20) default '0’

The Type column specifies the type of the badge transaction. A value of 0 specifies a call, a value of 1
specifies a broadcast, and a value of 2 specifies a Genie prompt.

ReportData text NOT NULL

The ReportData column stores the generated data.

48 VOCERA REPORT SERVER DATABASE SCHEMA GUIDE



DATABASE DETAILS

The inventory table stores data about the status of badges, useful for asset tracking reports. This table has
a primary key based on the TxMillis column.

Table 17: inventory table

Column

TxMillis

TxDateTime

TxDate

UserID

UserSite

BadgeMACAddr

APMACAddr

Voltage

UlState

SerialNo

Description

bigint(15) unsigned NOT NULL default 'O’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '©000-00-00 00:00:00'

The TxDateTime column stores the date and time of the event, accurate to the second.

date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.

varchar(70) default NULL

The UserID column specifies the user ID of the person logged in to the badge. This value corresponds to
a User ID specified via the Administration Console or the User Console on the Vocera server. If no user is
logged in, this value is the literal string NLI .

varchar(50) default NULL

In a multi-site installation, the UserSite column specifies the Vocera site with which the badge user is
associated. In a single-site installation, or if no user is logged in to the badge, this value is null.

varchar(12) default NULL
The BadgeMACAddr specifies the badge MAC address. Example value: 0009ef006e9a

varchar(12) default NULL

The APMACAddr column specifies the MAC address of the wireless access point with which the badge was
most recently associated. Example value: 000f24e9dce0

decimal(7,2) default '9.00'
The Voltage column specifies the badge battery voltage. Example value: 3.90

varchar(15) default NULL

The UlState column specifies whether a badge is in use (for example, on a call). Example values: Active,
Standby

varchar(30) NOT NULL

The SerialNo column stores the badge's serial number.

The locations table stores data about access points and named locations. This data can be defined using the
Locations screen of the Vocera server Administration Console. This table has a primary key based on the

MACAddress column.

Table 18: locations table

Column

MACAddress

LocationName

Site
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Description

varchar(20) NOT NULL default '@’

The MACAddress column specifies the MAC address of the wireless access point with which the badge was
most recently associated. Example value: 000f24e9dce0

varchar(50) NOT NULL default ''

The Location name column specifies the name of the location. Example value: The Lobby

varchar(50) default NULL

In a multi-site installation, the Site column specifies which Vocera site the location is associated with. In a
single-site installation, the value is the literal string s-global.
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Description

int(1) unsigned zerofill default '@’

The DeletedFlag column indicates whether an entry has been deleted (0 = false).
Although the entity may be flagged as deleted, it is not purged from the database because historical data
(that is, older report logs) may continue to reference it.

The loginlogout table stores information about when Vocera devices logged in and logged out. This table
has a primary key based on the TxMillis column.

Table 19: loginlogout table

Column

TxMillis

TxDateTime
TxDate

UserID

UserSite

Operation
DeviceMACAddr

APMACAddr

LoginUserCount

TotalLic

Description

bigint(15) unsigned NOT NULL

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '©000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.

date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.

varchar(70) default NULL

The UserID column specifies the user ID of the person who logged in or logged out. This value corresponds
to a User ID specified via the Administration Console or the User Console on the Vocera Server.

varchar(50) NOT NULL default ''

In a multi-site installation, the UserSite column specifies the Vocera site with which the user is associated.
In a single-site installation, this value is null.

varchar(64) NOT NULL default ''

Specifies the operation, either login or logout.

varchar(12) NOT NULL default ''
Specifies the device MAC address. Example value: 0009ef006e9a

varchar(12) default "'

Specifies the MAC address of the wireless access point with which the device was most recently associated.
Example value: 000f24e9dce0

int(11) default null

The current number of users that are logged in immediately following the Login or Logout operation.

int(11) default null

The total number of users login licenses.

The lostconnectiondetail table stores detailed information about each time a Vocera badge loses its
connection with the Vocera server, connects to an access point, or searches for a DHCP server. This table
has a primary key based on the id column.

Table 20: lostconnectiondetail table

Column

id

TxParentMillis
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Description

int(11) NOT NULL auto_increment

An incremental ID assigned to the lost connection instance.

varchar(15) default NULL

The TxParentMillis column is the unique identifier for the parent record in the lost connection log.
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TxMillis

TxDateTime

APMacAddress

OtherParty

Type
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Description

bigint(15) unsigned default NULL

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL

The TxDateTime column stores the date and time of an event, accurate to the second.

varchar(12) default NULL

The APMacAddress column specifies the MAC address of the wireless access point with which the badge
was most recently associated. Example value: 000f24e9dce0

varchar(20) default NULL

Source IP address that the badge received while in a call.

varchar(10) default NULL
Type of lost connection. Possible values are:
¢ SFAP—Searching for AP.

¢ SFS—Searching for Server.

¢ LCS—Lost Connection to Server.

e SFDHCP—Searching for DHCP.

¢ CAP—Connecting to Access Point.

The lostconnectionlog table stores summary information about badges that have lost their connection with
the Vocera server, connected to an access point, or searched for a DHCP server. This table has a primary
key based on the TxMillis column. For details about each record, go to the lostConnectiondetail table with
lostConnectiondetail.txParentMillis = lostconnectionlog. TxMillis.

Table 21: lostconnectionlog table

Column

TxMillis

TxDateTime
TxDate

UserID

UserSite

BadgeMacAddress
BadgeBinary
SFAPCount

CAPCount
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Description

bigint(15) unsigned NOT NULL

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '0000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.

date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.

varchar(70) default NULL

The UserID column specifies the user ID of the last person logged into the badge. This value corresponds to
a User ID specified via the Administration Console or the User Console on the Vocera server, unless the user
logged in with the built-in login ID Administrator, in which case this value is _ NONE__. See LoginId.

varchar(50) NOT NULL default "'

In a multi-site installation, the UserSite column specifies the Vocera site with which the user is associated.
In a single-site installation, this value is null.

varchar(12) default NULL
The BadgeMACAddr specifies the badge MAC address. Example value: 0009ef006e9a

text
Raw binary log sent by the badge.

smallint(6) NOT NULL default '@’

Number of times the user's badge went searching for an access point.

smallint(6) default NULL

Number of times the user's badge attempted to connect and authenticate at the access point.
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Column Description
LSCount smallint(6) default NULL

Number of times the user's badge lost the Vocera server connection.
SFSCount smallint(6) NOT NULL default '@’

Number of times the user's badge was searching for a Vocera server.
SFDHCPCount smallint(6) NOT NULL default '@’

Number of times the user's badge was searching for a DCHP server.
Duration smallint(6) NOT NULL

The Duration column specifies the duration of the lost connection, in seconds.

The messageactivity table stores information about voice messages, not text messages. This table has a

primary key based on the TxMillis column.

Table 22: messageactivity table

Column

TxMillis

TxDateTime

TxDate

UserType

UserlID

UserSite

Operation

Parties

Duration

IdMsgActivity
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Type
bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value
represents the number of milliseconds since January 1, 1970 (a date specified for
internal use by the report system). Because of the uniqueness constraint, it may not
reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '©000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.

date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.

varchar(20) NOT NULL default "'

Specifies which type of user initiated the message activity. Example values: User,
Phone

varchar(70) default NULL

Specifies the user ID of the person who initiated the message activity. This value
corresponds to a User ID specified via the Administration Console or the User Console
on the Vocera Server.

varchar(70) default NULL

In a multi-site installation, the UserSite column specifies the Vocera site with which
the user is associated. In a single-site installation, this value is null.

varchar(64) NOT NULL default ''

Specifies the operation; leavemessage is the only operation supported currently.

varchar(512) default NULL

Specifies a comma-delimited list of Vocera groups or users to which the message was
sent.

bigint(15) unsigned NOT NULL default '@’

Specifies the duration of the message activity in seconds.

bigint(15) unsigned NOT NULL default '@’

Identifies a Vocera message activity, which may not be unique. Any given message
activity could have the same IdMsgActivity value as another Message Activity that
took place earlier or later.
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Type
bigint(15) unsigned NOT NULL default '@’

The IdGenie column identifies a Genie session. A single Genie session may comprise
several events. For example, a Genie session for a badge-to-badge call may include the
"Vocera" prompt played on the calling party's badge and the "Can you talk to..." prompt
played on the called party's badge.

In the table, rows for events in the same Genie session have the same value in the
IdGenie column. However, this value is not guaranteed to be unique. Any given Genie
session could have the same IdGenie value as another Genie session that took place
earlier or later. One way to distinguish Genie sessions is to compare values in the
TxMillis column.

The posted table stores data about log files used by the Report server. The files themselves are stored on
the Vocera server in the vocera\logs directory. This table has a primary key based on the reportName

column.

Table 23: posted table
Column

reportName

reportTime

Description

varchar(50) NOT NULL default '@’

The reportName column specifies the name of a log file. Example value: report-jul01-0001.txt

bigint(15) NOT NULL default '@’

The reportTime column specifies, in milliseconds since January 1, 1970, the date and time a report log file
was posted to the server. Example value: 1120287620317

The radiodetail table stores detailed information regarding the audio quality experienced by Vocera badges
during a call. This table has a primary key based on the id column.

Table 24: radiodetail table

Column

id

TxParentMillis

TxMillis

TxDateTime

APMacAddress

OtherParty

PacketsReceived

PacketsMissed
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Description

int(11) NOT NULL auto_increment

An incremental ID assigned to the lost connection instance.

varchar(15) default NULL

The TxParentMillis column is the unique identifier for the parent record in the radio log.

bigint(15) unsigned default NULL

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL

The TxDateTime column stores the date and time of an event, accurate to the second.

varchar(12) default NULL

The APMacAddress column specifies the MAC address of the wireless access point with which the badge
was most recently associated. Example value: 000f24e9dce0

varchar(20) default NULL

Source IP address that the badge received while in a call.

smallint(6) default NULL

Total packets received before a new log event occurred. PacketsReceived and PacketsMissed are used to
compute the Packet Error Rate.

smallint(6) default NULL

Total packets missed before a new log event occurred.
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ca

RoamTime

Type

Reservedl

Reserved?2

Reserved3
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Description

smallint(6) default NULL

Communication Quality (CQ) value, which is an even number value on a logarithmic scale ranging from 0
to 92, where 0 represents no signal and 92 is the strongest possible signal with essentially no background
noise.

mediumint(9) default NULL

Specifies the Roam Time.

smallint(1) default '1°

1 if frames are unicast; 0 if frames are multicast.

mediumint(9) default NULL

Reserved for future use.

mediumint(9) default NULL

Reserved for future use.

mediumint(9) default NULL

Reserved for future use.

The radiolog table stores summary information regarding the audio quality experienced by Vocera badges
during a call. This table has a primary key based on the TxMillis column. For details about each record, go
to the radiodetail table with radiodetail.txParentMillis = radiolog. TxMillis.

Table 25: radiolog table

Column

TxMillis

TxDateTime

TxDate

UserID

UserSite

BadgeMacAddress

BadgeBinary

PacketsReceived

PacketsMissed

AvgCQ
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Description

bigint(15) unsigned NOT NULL

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '0000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.

date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.

varchar(70) default NULL

The UserID column specifies the user ID of the last person logged into the badge. This value corresponds to
a User ID specified via the Administration Console or the User Console on the Vocera server, unless the user
logged in with the built-in login ID Administrator, in which case this value is _NONE_ . See LoginId.

varchar(50) NOT NULL default "'

In a multi-site installation, the UserSite column specifies the Vocera site with which the user is associated.
In a single-site installation, this value is null.

varchar(12) default NULL
The BadgeMACAddr specifies the badge MAC address. Example value: 0009ef006e9a

text
Raw binary log sent by the badge.

smallint(6) default NULL

Total packets received before a new log event occurred. PacketsReceived and PacketsMissed are used to
compute the Packet Error Rate.

smallint(6) default NULL

Total packets missed before a new log event occurred.

smallint(6) NOT NULL default '@’

Average Communication Quality (CQ) value. A CQ value is an even number value on a logarithmic scale
ranging from 0 to 92, where 0 represents no signal and 92 is the strongest possible signal with essentially
no background noise.
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JBhit

JBMissed

Type

Reservedl

Reserved?2

Reserved3
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Description

mediumint(9) default NULL
Number of Jitter Buffer hits.

mediumint(9) default NULL

Number of Jitter Buffer misses.

smallint(1) default '1°
1 = Without Jitter Buffer data; 2 = New format with Jitter Buffer data.

mediumint(9) default NULL

Reserved for future use.

mediumint(9) default NULL

Reserved for future use.

mediumint(9) default NULL

Reserved for future use.

The recresults table stores speech recognition results. This table has a primary key based on the TxMillis

column.

Table 26: recresults table

Column

TxMillis

TxDateTime

TxDate

UserType

UserlID

UserSite

BadgeMACAddr

APMACAddr

RecStatus

Score

Recognized
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Description

bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '©000-00-00 00:00:00'

The TxDateTime column stores the date and time of the event, accurate to the second.

date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.

varchar(20) NOT NULL default '@’

The UserType column specifies which type of user uttered the speech. Example values: User, Phone

varchar(70) default NULL

The UserID column specifies the user ID of the person who uttered the speech. When the UserType value
is User, this value is either a User ID specified via the Administration Console or the User Console on the
Vocera server, or the literal string value  NLI__, which stands for Not Logged In. When the UserType
value is Phone, this value is the literal string _ PHONE__.

varchar(50) default NULL

In a multi-site installation, the UserSite column specifies the Vocera site with which the user is associated.
In a single-site installation, this value is null.

varchar(12) default NULL

The BadgeMACAddr specifies the badge MAC address. Example value: 0009ef006e9a

varchar(12) default NULL

The APMACAddr column specifies the MAC address of the wireless access point with which the badge was
most recently associated. Example value: 000f24e9dce0

varchar(40) NOT NULL default '’

The RecStatus column specifies the recognition status of the utterance. Example values: Recognized,
Rejected, NoSpeech

int(10) unsigned NOT NULL default '@’

The Score column specifies the recognition score for the utterance. Values range from 0 to 100.

varchar(50) default NULL

The Recognized column specifies the speech that was recognized by the Vocera system. Example values:
Wherels Randy Floren, Call Chris Long, Yes, LogOut
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Column

Grammar

DeviceType

IdGenie

DATABASE DETAILS

Description

varchar(64) default NULL

One of the Vocera speech recognition grammar categories, such as mainmenu, yesorno, forwardwhen,
singlename, messageresponse, and so on.

varchar(64) default NULL

Device type that initiates a call. Possible values: B1000, B1000A, B2000, B3000, MC70, and Smartphone. If
you have deployed Vocera Connect, other possible values are Cisco, Apple, and Android.

bigint(15) NOT NULL default '@’

The IdGenie column identifies a Genie session. A single Genie session may comprise several events. For
example, a Genie session for a badge-to-badge call may include the "Vocera" prompt played on the calling
party's badge and the "Can you talk to ..." prompt played on the called party's badge.

In the table, rows for events in the same Genie session have the same value in the IdGenie column.
However, this value is not guaranteed to be unique. Any given Genie session could have the same IdGenie
value as another Genie session that took place earlier or later. One way to distinguish Genie sessions is to
compare values in the TxMillis column.

The sites table stores data about Vocera sites. This data can be entered and edited via the Sites screen in
the Vocera server Administration Console. The table has a primary key based on the SiteId column.

Table 27: sites table

Column

Siteld

SiteName

DeletedFlag

Description

varchar(50) NOT NULL default '’

The Siteld column uniquely identifies a site. Example value: s-global

varchar(50) NOT NULL default '@’

The SiteName column specifies the name of a site. Example value: Global

int(1) unsigned zerofill default '@’
The DeletedFlag column indicates whether an entry has been deleted (0 = false).

Although the entity may be flagged as deleted, it is not purged from the database because historical data
(that is, older report logs) may continue to reference it.

The speechports table stores data about speech port usage.

Table 28: speechports table

Column

TxMillis

TxDateTime

TxDate

UserType

UserlID

UserSite
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Description

bigint(15) unsinged NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '©000-00-00 00:00:00'

The TxDateTime column stores the date and time of the event, accurate to the second.

date NOT NULL default '0000-00-00'

The TxDate column stores the date of an event, accurate to the day.

varchar(20) NOT NULL default '’

The UserType column specifies which type of user uttered the speech. Example values: User, Phone

varchar(70) default NULL

The UserID column specifies the user ID of the person who uttered the speech. When the UserType value
is User, this value is either a User ID specified via the Administration Console or the User Console on the
Vocera server, or the literal string value _ NLI__, which stands for Not Logged In. When the UserType
value is Phone, this value is the literal string _ PHONE_ .

varchar(50) default NULL

In a multi-site installation, the UserSite column specifies the Vocera site with which the user is associated.
In a single-site installation, this value is null.
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Column

Duration

SpeechPort

IdGenie

DATABASE DETAILS
Description

mediumint(8) unsigned default '@’

The Duration column specifies the duration of the utterance, in seconds.

int(5) unsigned NOT NULL default '@’

The SpeechPort column specifies which speech port processed the utterance. Example value: 3

bigint(15) unsigned NOT NULL default 'O’

The IdGenie column identifies a Genie session. A single Genie session may comprise several events. For
example, a Genie session for a badge-to-badge call may include the "Vocera" prompt played on the calling
party's badge and the "Can you talk to ..." prompt played on the called party's badge.

In the table, rows for events in the same Genie session have the same value in the IdGenie column.
However, this value is not guaranteed to be unique. Any given Genie session could have the same IdGenie
value as another Genie session that took place earlier or later. One way to distinguish Genie sessions is to
compare values in the TxMillis column.

The systeminfo table stores data about Report server. This data is entered via the Administration screen of
the Report server Administration Console.

== Note:

Although the systeminfo table does not store Vocera usage data, it is commonly used by the standard

Report Server reports to display system information.

Table 29: systeminfo table

Column

CompanyName

ServerIp

BackupInfo

DataLoadInfo

Password
MailInfo

SweepInfo
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Description

varchar(150) default '@’

The CompanyName column stores the name of the company where Vocera is installed.

varchar(120) default NULL

The Serverlp column stores the comma-separated list of IP addresses or DNS names of the Vocera server.
If the Vocera server is not clustered, this column contains only one IP address or DNS name. The report
server uses this information to fetch data from the Vocera server. Example values: 12.123.11.1, 127.0.0.1,
myserver

text

The BackupInfo column specifies how often Report server data is backed up. The value represents
information entered in the following fields of the Backup page of the Administration screen: Enable
Automatic Scheduled Backups, Backup Frequency, Backup Time, and Maximum Number of Backup Files to
Save.

The field values are separated by a vertical bar ( | ). Backup times are presented in milliseconds from
midnight. For example, the following value specifies automatic backups every 2 days at 2:00 a.m., retaining
a maximum of 5 backup files:

true|2|7200099|5
text

The DataLoadInfo column specifies how often the Report server loads data from the Vocera server. The
value represents information entered in the following fields of the Data Load page of the Administration
screen: Enable Automatic Scheduled Data Load, Load Data Frequency, and Data Load Time.

The field values are separated by a vertical bar ( | ). For example, the following value specifies automatic
data loading every day at 4:00 a.m.

true|1|14400000 |

Data load times are presented in milliseconds from midnight. Note the trailing vertical bar after the time.

varchar(100) default NULL

The Password column stores the Administrator password for the Report server. This value is encrypted.

text

Specifies mail server information. The values are separated by a vertical bar ( | ).

text

Specifies server sweep information. The values are separated by a vertical bar ( | ).
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The unansweredcalls table stores data about calls that were not answered.

Table 30: unansweredcalls table

Column Description

TxMillis bigint(15) unsigned NOT NULL

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

Called varchar(40) NOT NULL
The Called column stores the user ID of the called party
CallID bigint(20) NOT NULL default '20'
The CallID column stores the ID of the call as entered in the Vocera server log.
GenieID bigint(10) NOT NULL default '@’
The GenieID column stores the ID of the Genie session as entered in the Vocera server log.
ReasonID int(2) NOT NULL default '@’
The ReasonID column stores an integer that maps to a Reason string.
Reason VARCHAR(25) NOT NULL

The Reason column stores a string that explains why the call was unanswered.
Possible values:

* Busy

e (Call rejected

e (Call wait rejected

¢ (Caller blocked

* Not logged in

* Not online

¢ Phone not answered

e Unavailable

The users table stores data about badge users. This data can be entered and edited via the Users screen
in the Vocera server Administration Console or the Basic Information screen of the Vocera server User
Console.

Other tables in the Vocera Report Server schema contain a UserID column that corresponds to the
UserID column in this table. Therefore, you can write queries that return data about badge users in other
contexts.

For example, the following query returns data about badge users in the context of a report about
broadcasts:

select * from broadcasts, users
where broadcasts.UserID = users.UserID

This table has a unique key based on the UserID column.

Table 31: users table

Column Description

UserID varchar(70) NOT NULL default ''

The UserID column specifies a user ID entered via the Administration Console or the User Console on the
Vocera server. Example value: ALINCOLN

UserName varchar(255) NOT NULL default "'

The UserName column stores the value of the FirstName column, a space, and the value of the LastName
column. Example value: ABRAHAM LINCOLN
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Column

LastName

FirstName

Departments

Site

CostCenters

DeletedFlag

Email

DATABASE DETAILS

Description

varchar(50) NOT NULL default "'

The LastName column stores the user's last name. Example value: LINCOLN.

varchar(50) NOT NULL default ''

The FirstName column stores the user's first name. Example value: ABRAHAM

varchar(100) default NULL

The Departments column lists department groups that the user belongs to. Multiple department names are
separated by a plus sign (+). Example values: Engineering, Admin+Marketing+Sales

varchar(50) default NULL

The Site column lists the site ID (not the site name) of each site the user is associated with. Example value:
s-global

varchar(100) default NULL

The CostCenters column specifies the user's cost centers. Multiple cost centers are separated by a plus sign
(+). Example values: Engineering, Admin+Marketing+Sales

int(1) unsigned zerofill NOT NULL default '@’

The DeletedFlag column indicates whether a user has been deleted (0 = false).

Although the entity may be flagged as deleted, it is not purged from the database because historical data
(that is, older report logs) may continue to reference it.

varchar(100) default NULL

Specifies the user's email address.

The vmiactions table stores data about actions performed by recipients in response to messages sent from
Vocera Messaging Interface clients.

This table has a unique key based on the TxMillis column.

Table 32: vmiactions table

Column

TxMillis

TxDateTime

TxDate

ClientID

MessagelD

RecipientType

RecipientSite

RecipientID

RecipientName

ActionType
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Description

bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '0000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.

date default NULL

The TxDate column stores the date of an event, accurate to the day.

varchar(50) NOT NULL default ''

The unique ID of the Vocera Messaging Interface client.

bigint(20) unsigned NOT NULL default '@’

The Vocera Messaging Interface message ID, which must be unique for the client.

varchar(20) NOT NULL default ''

Specifies which type of Vocera entity (for example, user or group) received the message.

varchar(50) default NULL

In a multi-site installation, the RecipientSite column specifies the Vocera site with which the recipient is
associated. In a single-site installation, this value is null.

varchar(70) NOT NULL default ''

Specifies the ID of the message recipient.

varchar(100) default NULL

Specifies the name of the message recipient.

varchar(50) NOT NULL default ''

Specifies the type of action. Sample values include: Accepted, Rejected, Delivered, Read, and Response.
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ActionDetail

DATABASE DETAILS

Description

text NOT NULL

Specifies detailed information about the action. For example, if the action type is Response, the response
could be OK, Busy, or Cancel, which would appear in the ActionDetail column. If the action type is
Rejected, the ActionDetail column might show "User is not logged in" to explain why the message was
rejected.

The vmievent table stores data about events logged by Vocera Messaging Interface clients. This table has a
unique key based on the TxMillis column.

For information about how to log information about external events—such as those from a middleware
system—to Vocera Report Server logs, see the LogEvent () method in the Vocera Messaging Interface

Guide.

Table 33: vmievent table

Column

TxMillis

TxDateTime

TxDate

ClientID

EventID

EventType

Iteml

Item2

Item3

Item4

Itemb

Item6

Item7

Item8

Item9

Item10
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Description

bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '0000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.

date default NULL

The TxDate column stores the date of an event, accurate to the day.

varchar(50) NOT NULL default ''

The unique ID of the Vocera Messaging Interface client.

bigint(20) unsigned NOT NULL default '@’
VMI event ID.

varchar(30) default NULL

Specifies VMI Event type, supported even type are, MessageEvent, CancelEvent, SystemEvent

varchar(64) default NULL
Stores the first item in the event info specified by the logged VMI event.

varchar(64) default NULL

Stores the second item in the event info specified by the logged VMI event.

varchar(64) default NULL
Stores the third item in the event info specified by the logged VMI event.

varchar(64) default NULL
Stores the fourth item in the event info specified by the logged VMI event.

varchar(64) default NULL
Stores the fifth item in the event info specified by the logged VMI event.

varchar(64) default NULL
Stores the sixth item in the event info specified by the logged VMI event.

varchar(64) default NULL
Stores the seventh item in the event info specified by the logged VMI event.

varchar(64) default NULL
Stores the eighth item in the event info specified by the logged VMI event.

varchar(64) default NULL
Stores the ninth item in the event info specified by the logged VMI event.

varchar(64) default NULL
Stores the tenth item in the event info specified by the logged VMI event.
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The vmimessages table stores data about messages sent by Vocera Messaging Interface clients.

This table has a unique key based on the TxMillis column.

Table 34: vmimessages table

Column

TxMillis

TxDateTime

TxDate

ClientID

DestinationType

DestinationSite

DestinationID

DestinationName

MessagelID

Priority

MessageText

Description

bigint(15) unsigned NOT NULL default '@’

The TxMillis column gives each row in the table a unique identifier. The value represents the number of
milliseconds since January 1, 1970 (a date specified for internal use by the report system). Because of the
uniqueness constraint, it may not reflect the exact actual date and time of the event. See TxDateTime.

datetime NOT NULL default '©000-00-00 00:00:00'

The TxDateTime column stores the date and time of an event, accurate to the second.

date default NULL

The TxDate column stores the date of an event, accurate to the day.

varchar(50) NOT NULL default '’

The unique ID of the Vocera Messaging Interface client.

varchar(20) NOT NULL default '’

Specifies which type of Vocera entity (for example, user or group) was sent the message.

varchar(50) default NULL

In a multi-site installation, the DestinationSite column specifies the Vocera site with which the destination
is associated. In a single-site installation, this value is null.

varchar(70) NOT NULL default '’

Specifies the ID of the message destination.

varchar(100) default NULL

Specifies the name of the message recipient.

bigint(20) unsigned NOT NULL default 'O’

The Vocera Messaging Interface message ID, which must be unique for the client.

varchar(20) default NULL
Specifies the Vocera Messaging Interface priority (Normal, High, or Urgent).

text NOT NULL

Specifies the content of the message. The length of the message is limited to 256 characters.

The following tables contain Report Server application data rather than Vocera usage data. These tables
should not be used to create custom reports.
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diskdestination
jobexceptions
jobupdates

mailinglist

package
packagedestination
packagereports
packageschedule
packageschedulehistory
reportconfiginfo
reportparameters
scheduledreporthistory
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task

taskconfiginfo
taskexceptions
taskexecutables
taskjobupdates
taskparameters
taskschedule
taskschedulehistory

DATABASE DETAILS
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